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			Foreword

			I’m assuming that due to the title of this book you might be a bit like me, you’re that person from department XYZ who’s good with Excel and interested in learning Power BI. Welcome to the book. 

			I’m a massive fan of Power BI and Excel and I’ve been building solutions for clients using both products for many years. I’ve also trained a few thousand people in Excel and Power BI so I know the common hurdles and challenges that people face.

			My first taste of data was as a fresh-faced intern with Hewlett Packard back in 1995. I was quickly hooked on Lotus123, one of the earliest spreadsheet packages, and within 8 months I had automated away most of my month-end tasks. I clearly had a knack for this stuff. Over the following years, I moved through my career learning more tricks and techniques from colleagues and the occasional training course. I always enjoyed the data part of my job. I liked the puzzles work presented and the workarounds and hacks were challenges that I enjoyed. 

			In 2007 I moved to Perth, Western Australia, and joined a dedicated Excel consulting and training company, I’m still there now. My timing was perfect as Excel was suddenly on a rapid path of improvement. Excel 2007 and 2010 with a new Ribbon and Tables and then… then came the big one… the functionality known as Power Pivot, closely followed by Power Query. If you haven’t heard of these things, then you’re not alone.  

			A silent revolution happened to Excel. In plain sight but under cover of add-ins and understated menus.

			Power Pivot and Power Query – the Parents of Power BI

			Have you heard of the concept of a “sleeper car”? It’s when someone takes a boring-looking beaten-up old car and puts fuel injection and souped-up suspension in it.

			Power Pivot and Power Query brought that super-power to Excel. Suddenly you could build highly flexible reports that could be updated with a click of a button. No longer were you limited to 1 million rows of data or chained to the laborious tasks of copy-paste then filtering and writing thousands of VLOOKUPS that you must remember to drag down when new rows of data get added.

			I think more people have now heard of Power BI than have heard of Power Pivot or Power Query, but the core concept was born out of making analysis easier for Excel users. The Power BI of today started by taking Power Query, Power Pivot, and a visualisation layer called Power View and wrapping them together into a single package. Have no doubt that Excel and Power BI are still strongly related with a core set of genes that are infused into both. 

			☕ If you’d like to hear more about the history of the product then I’d recommend this interview between Amir Netz (CTO of Microsoft Analytics) and Kasper de Jonge (Principal Program Manager Power BI) url.pbi.guide/kasper. At the 20-minute mark, Amir discusses how he came up with the algorithm for the magic behind the scenes of the Power Pivot / Power BI “engine” while sitting naked in his kitchen!

			Why I Wrote this Book

			I love helping people and I feel there is space for a book that gives an overall instructional guide on how to get started in Power BI aimed at the Excel Analysts of the world. There are millions of us and Power BI’s popularity is continuing to grow.  

			There are many great books out there that I have learned from, and they tend to have a focus on single elements such as Power Query or DAX or come at Power BI from an IT user perspective.

			I wanted to be able to recommend a book to people that covers the whole Power BI process aimed at Excel users transitioning to Power BI. This has been my story and I think I have learned from enough mistakes over the last 7 years and seen enough people struggle with certain elements that I’m well positioned to write a book that helps Excel users make a successful start with Power BI.

			The challenge with writing a book on Power BI is how quickly it changes and what to leave out.  Since its launch in May 2015 Power BI has developed at an astonishing pace. Every month there are multiple updates, and it has now grown into a fully-fledged Business Intelligence ecosystem.  It pulls together the two worlds of the Excel Analysts and the corporate IT departments with a shared product and language.   

			This book aims to help you learn the core essentials of Power BI from the viewpoint of an Excel user. Excel is the world’s most popular programming platform. That’s right, if you’re writing Excel formulas you ARE a programmer. Put “Functional Language Programmer” on your résumé right now! Many of us push Excel to its limits, creating and copying hundreds of thousands of formulas, VLOOKUPS, and XLOOKUPS everywhere, throwing in some Macros where required.  But there is now a new way to build robust refreshable reports without any of that.

			Chapter 10 of this book is an “Intermission for Excel fans”. This goes a little into the history of Power Pivot and Power Query and shows you how to apply the things you have learned in the book to Excel. One of the main reasons I’m such a fan of Power BI is that it doesn’t force you to choose Power BI or Excel, it’s about using both with a shared set of techniques.

			I hope the book gives you a kick-start on your learning journey.

			☕ It’s virtually guaranteed that the names or positions of certain buttons, labels and other elements will have changed by the time you read this book. However, the core principles you learn here will remain relevant for many years, so I hope you can forgive any user interface discrepancies. It’s simply impossible to have a book that is in exact step with a product that is evolving so rapidly.
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			Chapter 1 - Getting Started with Power BI

			Power BI allows you to create and share robust, interactive, refreshable reports in a secure environment. It is a platform consisting of several elements that allow report creators to provide information that is easily accessible and easily refreshable.

			Power BI was officially launched in July 2015 and is rapidly becoming commonplace in workplaces around the world. You may well have seen it in action already.

			The aim of this book will be to teach you how to build a simple interactive report like the image below and for you to understand how to refresh it and share it with others.  

			Importantly I’ll be sharing my best practice tips and advice to give you a solid foundation in building and sharing reports the right way.

			[image: ]

			Power BI has brought about a complete change from the old days of Business Intelligence projects. Those solutions required dealing with software salespeople followed by weeks of requirements gathering by business analysts. The requirements were then sent to distant developers creating what they think you said you need, rounded off with “out of scope” re-work. Ultimately the project took 6-12 months, and it was then out of date or not exactly what the business needed.

			Power BI enables business users, especially those currently “living” in Excel, to build these fully functional business intelligence solutions themselves in a few weeks. This is not hyperbole; it is a proven fact. The ability for someone who already knows the business to quickly build something useful is what Excel analysts have always done. The difference with Power BI is there’s now an entire ecosystem designed to make these reports more robust and easier to scale out and re-use.

			Power BI consists of 2 main elements:

			1.	Power BI Desktop is where you build your reports 

			2.	PowerBI.com (otherwise known as “the service”) is where you share your reports

			[image: ]

			Power BI desktop consists of 3 core areas of functionality.

			Power Query is the World’s greatest washing machine for dirty data. It allows you to connect to different sources of information and re-organise it to make your report creation easier. If you’ve ever copied and pasted multiple blocks of data, filtered a column, used Text to Columns, MID, RIGHT, LEFT, CONCATENATE, etc. then Power Query will blow your mind!

			The Data Model is the world’s greatest data wardrobe. Hang up all your nice clean data (from Power Query) and then organise the related items so that you can easily press a button to see blue clothes or shirts or evening wear. An Excel sheet has about 1 million rows, whereas the Power BI Data Model can technically hold unlimited rows and 1,999,999,997 distinct values per column. Yep, that does say 2 billion! 

			The Canvas is where you add your visuals using the data from your Data Model. Charts, Tables, Matrix visuals, Slicers, buttons, text boxes all contribute to communicating useful information to the report consumer to assist them in making an informed decision.

			This is also where you start to write formulas to enrich your report with ratios, variances, cumulative totals, etc. This formula language is called DAX (Data Analysis eXpressions) and takes your reporting to the next level. 

			PowerBI.com, also known as “the service”, is where you save your reports to share with others. The report consumers can log in to PowerBI.com to view the reports that have been shared with them. Alternatively, the reports that have been published to PowerBI.com can be embedded into Teams, SharePoint, and even websites. There is also the ability to share a report with the entire world for free via a Publish to Web option. The Data Model you build for your report can also then be connected to via other Power BI reports and Excel to create a suite of reports from this “single source of truth”.

			Getting Set Up

			Before you start with Power BI you will need to have Power BI Desktop installed on your machine (Windows machines only, no Mac sorry). Your IT department may be in control of this process and have different methods to the ones I’m about to suggest.

			The recommended approach is to install the version from the Microsoft Store as this automatically stays up to date. Make sure it is Power BI Desktop that you download, as there’s also a view only application called Power BI. Here’s the link to the correct version https://aka.ms/pbidesktopstore

			Occasionally this option may be blocked for you, so then you will need to go to https://powerbi.microsoft.com/en-us/desktop/ or use this shorter link url.pbi.guide/Man64 where you will see something like the screenshot below. I’m sure these screens will change by the time you’re reading this book, but hopefully, you’ll get the idea.

			You’ll ignore the Download free button (1) as that simply takes you to the Microsoft Store version again. Click “See download or language options” (2). You should pick the 64-bit version. With this method, you will then be prompted each month to download the new updated version.

			[image: ]

			💡 The 64-bit version can utilise more RAM from your machine and is, therefore, a more powerful and less crash-prone option than the alternative 32-bit version. The more RAM you have on your machine the better when it comes to Power BI. It will improve your report development experience as tasks will run quicker. In my view, 16GB RAM is the minimum that you need.

			Using this Book and Downloading Sample Files

			For the best result, you should follow along with the Power BI software open in front of you, clicking the clicks, and physically replicating the exercises. There is no substitute for hands-on practice to help you remember what you need to do. However, I also wanted people to be able to read this book and follow along even without a copy of Power BI desktop to play with.  Hopefully, I’ve achieved that.

			I’ve added a lot of screenshots marked up with icons that I will reference in the paragraphs before the image such as the black numbered icons like (1) which generally indicate something you should (left) click on. Yellow icons like (2) which mean look but no need to click, and then green icons next to a mouse signifying a right-click (3). There’s also the occasional use of orange rectangles and arrows just to highlight elements.

			[image: ]

			You will notice a few icons have been used in comment boxes

			☕ - coffee chat moments, consisting of my thoughts and general comments

			💡 - insights and tips that relate to the topic

			⚠ - warnings and other very important things to be aware of

			Download the Exercises and view the List of URLs 

			I have created a companion website for this book called PBI.guide, where you can download all the exercies and files used in this book (see 2 in the screenshot below) along with example Power BI files at various stages of completion as the book progresses. For a direct link to the downloads page use this shortened URL url.pbi.guide/PBIXL. After you download the zipped folder, you will need to extract the files or open it and copy and paste the exercises folder into a different location. That page also includes all the links referenced in this book, so if you’re reading this in hard copy go to that page and simply click the links there. 

			If you are going to use the solution files I’ve created, then I recommend that you open the folder called Solution Files and read the PDF “Changing connections on the solution files to point to your system”.

			The PBI.guide Website

			PBI.guide is a useful resource for continuing your Power BI learning journey beyond the end of this book. I will be adding content, articles, and flagging updates to keep you up to speed with the rapidly evolving world of Power BI. Bookmark the site or add it to your favourites bar for ongoing future reference.
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			Chapter 2 - First Look – an Introduction to Power BI Desktop

			Once you have downloaded the folder as mentioned on the previous page, go into the exercises folder, and double-click on the file called First Look Demonstration. This should launch Power BI desktop. For those of you not sitting in front of your laptop don’t worry we’ll have screenshots for it all.  

			💡 You can also look at the online version via url.pbi.guide/FirstLook, noting that you don’t need to hold Ctrl when clicking buttons with the Web Version

			The cover page should appear.

			Interacting with a Power BI Report

			
					Hold the Ctrl key and click on the button labelled First Look (1)
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			These first few pages are simply a showcase of a few of Power BI’s report features. The detailed instructions will come in later chapters, for now just follow along and see what’s possible.
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					Hold Ctrl and click on the Show Tips button in the top right corner (1) and multiple text boxes will appear with tips about how you can interact with the report
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			💡 You quickly discover that when building reports in Power BI desktop you must hold the Ctrl key when clicking buttons to trigger their action. The report consumer will not need to hold Ctrl once you share this report with them via Power BI.com. Clicking on bars or values in visuals will magically “filter” the other visuals on the page. This does not require you to hold Ctrl.

			
					Left-click on any bar in any visual. This causes all the other visuals to be filtered by that selection. This means that consumers of your report can explore the information you provide and potentially answer their own specific questions without having to come back to you and ask for a slightly different view of the data. This is fantastic!

					Click on the same bar a second time to remove that filter and return the report to its original state. 

			

			From this point on, unless the book states to use the right-click option then assume “click” means left-click

			
					Right-click on the bar for the brand “Reboot” (1) and Drill down (2) to see the products 

			

			[image: ] 

			
					Right-click on one of the product bars (1) and select drill up (2) to return to the original display
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					Hover your mouse over the bar for Brisbane (1). A tooltip will pop up giving more information
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					Click on the Reset button in the top right corner to remove any filters you may have applied. Remember that you need to hold the Ctrl key when you click the button

					Right-click on the Neptunes Restaurant February value of 20 (1) and then hover over the Drill through option and click the Sales Detail label (2) 

					You will jump to a page showing detailed transactions for that customer. Ctrl-click the “Back Button” (3) to return to the main page
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					Click on the Analysis Page. This page contains a visual called the Decomposition Tree which allows you to explore the factors influencing Actual Sales $

					Click on the different branches to explore the data, and hovering will also display the tooltip!
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			You will explore and understand these features along with many other elements as you progress through the book.

			The Four Screens of Power BI Desktop

			The Report Canvas (1). It’s the one you’re already seeing and is where you add your charts and other visual elements that the report consumer will see and interact with.

			The Data View (2) where you can see the underlying data.

			The Model View (3) where you link tables to each other.

			Power Query (4) where you connect to and clean up/reorganise your data into well-structured tables. This is where your Power BI journey will start in the next chapter.

			[image: ]

			To wrap up this “first look” chapter take a quick look at screens 2 and 3.  

			
					Click the data view icon (see 1 in the image below). This screen is never visible to the report consumer. It is an interface where you, as the report builder, can view and filter and sort the data without impacting the report in any way. There is the ability to add extra calculated columns but more on that later

					Clicking the name of a Table of data on the right (2) changes which data is being displayed

			

			[image: ]

			☕ Occasionally I’ve seen those learning Power BI mix up this screen and the Power Query screen. You’ll see next that they do look similar at first glance, but they are very different. The important thing to note for now is that filtering your data here has no impact on your report.

			
					Click the Model View icon (see 1 in the image below)  

			

			This is where much of the real power of Power BI lies. It is here that you relate tables to each other so that data can be sliced and diced a hundred different ways without having to write thousands of different formulas. It’s in this screen that a single line between 2 tables can replace millions of lookup type formulas. Whether you use VLOOOKUP, INDEX MATCH or XLOOKUP think about the power that replacing millions of formulas with a few lines can give you.

			[image: ]

			That’s the brief introduction and first look at Power BI desktop. I hope that you’re interested in learning more about these features and building some beautiful, useful reports that are simple to update.

			
					Close this demonstration file, there’s no need to save any changes

			

			You will now build a report from scratch starting with what I consider to be the greatest ever development for the Excel Analyst… Power Query.

			Introducing Power Query

			Power Query is the Worlds’ greatest washing machine for dirty data.

			I’ve worked with companies of all sizes, and no matter how big the company is there’s always a need to clean up the data before you can present or analyse it.

			It is truly a revolutionary feature that was originally an add-in for Excel. It’s now natively part of Excel, found under the Data tab, and it’s the same Power Query that exists in Power BI. The Power Query lessons in this book are therefore also applicable to Excel. As you’ll see later you can even easily copy and paste queries between Excel and Power BI.

			☕ I’ve seen people’s jaws drop when I show them what Power Query can do and then tell them it’s been built in since Excel 2016. They feel a combination of excitement that their daily lives are about to get much easier coupled with low-level resentment that no one told them about this earlier!

			Importing and Cleaning Data using Power Query

			Here are the steps you’ll follow to introduce Power Query in the context of Power BI:

			1.	You will import some data from an Excel file 

			2.	Clean it up and re-organise it 

			3.	Load it into the Power BI file and build a simple chart 

			4.	Then go back into Power Query and do a little extra data clean up

			
					Before you start, open the following file in Excel just to see what the data looks like: Exercises\Data Sources\Gym Membership\Gym Membership.xlsx
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					Close the Excel file before proceeding. Power Query sometimes is unable to pull in data from open files. The screenshot above gives you an idea of the contents of the file

					Start a new Power BI file. If a cover screen appears close it (1)
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			There are 3 different points you can click to import data from Excel. They all do the same thing, which is to allow you to connect to an Excel file and then import the data.

			[image: ]

			
					Click on any of the 3 Excel icons shown above and then navigate to the folder Exercises\Data Sources\Gym Membership\

					[image: ]
Double-click on the Membership Data Excel file (1) 

					This launches the Power Query Navigator window as shown below. The left-hand side lists any sheets, Tables, or range names that exist in the Excel file.  

					Click on the word “Members” (1) and a preview appears  

					Right-click on the word “Members” (2) and 2 options appear

					Click on Transform data (3). 99% of the time you choose Transform data as this then allows you to clean up the data in the “washing machine” before you load it into the Data Model

			

			[image: ]

			💡 As an alternative to the right-click option, you could instead tick the check-box next to Members and then use one of the buttons in the bottom right corner. The check-box method is useful when there are multiple sheets or tables to transform or load in one go.

			You are now in the wonderful world of the Power Query Editor, look at the following items in the screenshot below.

			1.	The 3 key menus to use when converting data into well-structured tables

			2.	The list of your Power Query tables and other elements. You normally have more than one table of data in your Power BI data model

			3.	The data preview area, showing the first 1,000 rows of your data

			4.	The Formula bar, showing the “M” language formula

			5.	Just a few of the magical Power Query buttons that help you convert your messy source data. There are more buttons on each of the 3 menus

			6.	Query Name. Short and meaningful names should be used

			7.	The Query Steps, where each click of a button is recorded as a single step

			[image: ] 

			💡 If the formula bar is not visible then click on the View tab and tick the checkbox for the formula bar. You can gradually begin to learn the “M” language by reviewing the formulas that are generated by button clicks. “M” stands for Mashup. 

			Start by looking at the Applied Steps in the right-hand panel.

			
					Click on Source (1) and it shows you the connection to the Excel file in the formula bar. The contents of that Excel Workbook is then shown in the preview area
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					Click on the Navigation step. The preview pane then shows the contents of the Members sheet since this is the sheet you selected in the navigation pane at the start of this process

			

			Then Power Query tried to be helpful and added two more steps automatically for you. The Promoted Headers step (2) pushes the first row of your sheet into the column headers. The Changed Type step (1) is created by Power Query scanning the columns to work out if they are filled with dates, numbers, text, etc.

			We’ll come back to these items later, but for now, you should delete them as you can see the headings are actually in row 2.

			
					Delete the Changed Type (1) step by clicking the cross next to it

					Delete the Promoted Headers step (2)
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			Now that you are back to the navigation step, you will see the heading you need is in row 3. To remove the top 2 rows, there is a helpful button on the Home tab called “Remove Rows” (1). 

			
					Click Remove Rows (1)

					Choose Remove Top Rows (2), then type a 2 in the box that appears followed by OK
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					Click the “Use First Row as Headers” button (1) and the first row will be promoted into the column headings

			

			[image: ]

			☕ Use First Row as Headers is possibly my favourite named button in all of Power BI. Bravo Power Query team!  

			Now you can see in the right-side panel that not only has the Promoted Headers step been added, but an extra Changed Type step also appears. Power Query has scanned your columns and added this Changed Type step to set your columns as Whole Number (123), Text (ABC), etc.
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			For those of you that have recorded Macros in the past, this is a much simpler and clearer process. You see the steps being added, you can delete the mistakes that you’ve made, and you can easily go back and edit or insert a step.

			The real power of Power Query is that these steps can now be run at any time in the future by clicking a refresh button, or even by scheduling it to run at certain times of the day.  

			Before you do any further clean up to this data you probably want to know where this is leading, so load the data as it is then you can come back later to finish cleaning it up.

			
					On the Home tab click Close and Apply, there’s no need to click the drop-down, just click the big button (1)

			

			[image: ]

			The data is now loaded into the data model and the Members table appears in the Fields Panel on the right-hand side of the screen.    

			
					Click the expand icon (1) to open up the table and display all the columns in the table
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			Create Your First Power BI Visual

			
					Tick Package (1) followed by Member Number (2) and a table of results should appear. But Member Numbers are being summed up, which is not what you want 

					Click on the small V arrow next to Member Number (3) and choose Count (4)
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					Change the visual to a Clustered bar chart (1)
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			And now you have a chart showing count of members by package type. This is the start of your Power BI journey. From this point, you could then add more visuals to the page and build out your report.

			To see my file at this stage open Solutions\Chapter 2 Gym Report Stage 1

			You should save your file at this stage before you go any further.

			
					Click on File then Save As and call it Gym Report

			

			There are 3 buttons you will use frequently when developing Power BI reports, see the image below. No need to click items 1 or 2 right now, but you will click option 3.

			Publish (1). When you are finished building a report you would click Publish which saves your report to PowerBI.com. We’ll come back to this later. This then allows you to share your report with others.

			Refresh (2). To update the report with the latest data you click Refresh. This runs the Power Query Applied Steps, the visuals update and then you click Publish to replace the previously shared report.  
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